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Using KiNG and Molikin

Kinemage-Construction Tutorial - Ricin
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Ricin is a complex toxin capable of crossing membranes and inactivating ribosomes by cleavage at a specific
site in the RNA. It is composed of two unrelated polypeptide chains, with the catalytic site in the alpha/beta A
chain, two similar antiparallel-beta domains in the B chain, and four bound carbohydrates. Its crystal
structure was determined by Robertus and colleagues at the Univ. of Texas, and is PDB file 2AAI. This
original file did not have secondary structure assignments for the B-chain, so we will be working from an
edited version where these assignments have been added: "2AAIed.pdb"

The first thing to do is to get a feel for what the structure is like to help plan strategy for what would be
interesting to show in 3D graphics. 
Open 2AAIed.kin in KiNG with "Lots-new kinemage". You will see that it has Chain A, Chain B, and a third
group which turns out to be the "Het" atoms - in this case carbohydrates (sugars) that turn out to be attached
to Chain B. Move around the 3D image, turn things on and off, get a feel for size and relative postions of the
chains. Can you see that Chain B has two domains? Find the catalytically important Glu A 177 (e.g. Edit/Find
point "cd Glu A 177") move around and see the active site cleft. One objective of making a kinemage is to
provide clear views of these various features that are buried in the visual clutter of a "lots" visualization.
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Kinemage 1 - a simple Calpha-backbone (from which to start)

For an initial look at the ricin molecule, we will run a simple script on file  2AAIed.pdb. 
EITHER Drag-n-drop the pdb file onto KiNG and when asked what you like to do... Select "Open the file in
Molikin" to get the Molikin Dialog Box. 
OR ELSE launch KiNG and open the file from its 'File | Import | Molecules' menu; find and select your
downloaded 2AAIed.pdb, "open" to get the Molikin Dialog Box. 

In the left side panel select "Ball & Stick". Select Chains A and B, all Numbers, all Types. Color by
mainchain/sidechain, select protein, hets (non-water), C-alpha trace, and disulfides. Choose "as new
kinemage" (DO NOT click "Done" - later we will come back to this Molikin Dialog Box to add features to
the kinemage image). This will produce Calphas, disulfides, and non-water het groups for all subunits in the
file. The resulting kinemage will appear in the KiNG graphics window so you can look at it.

You should see Calpha backbones for the two ricin chains in different colors, with yellow disulfides and
several bound sugars (pink). Move it around by dragging with the mouse. Such a simple, default kinemage
shows many of the features of the structure, and is useful for many purposes. Note, however, that the
viewpoint is arbitrary, the default colors and the names and arrangements of buttons are not ideal, and the
sugar units are not connected to the protein. If you want to show particular details and get your point across
to someone unfamiliar with the structure, then there are many ways to make the kinemage more informative
and persuasive.

Choosing and saving views

First move around to find a view that spreads out the 3 domains in the plane of the screen, with the A chain
(the white one) at the top. See if you can enlarge the zoom factor by a bit without going off the screen edges.
Type "s" on the keyboard to toggle into stereo, to make sure your zoom and orientation allow seeing most of
the important parts in stereo (you can check for that, even if you can't see stereo yourself). Try improving the
depth-cueing by dragging the 'Clipping' slider until something gets clipped away in the back or front, and
then back off a step or two. (You can also zoom and clip by dragging with the right mouse button.) Recenter
using 'pick center' if needed. Alternately, hit the "f" key to toggle to moving flat on the screen rather than
rotating, or move in "flatland" by dragging with the middle mouse button. Dragging across the top of the
screen moves the view center in or out of the screen. Once satisfied, choose the 'Views | Save current view'
menu item, and save this with a name such as "overview". Move the image, then choose your view under the
View menu, which should reproduce the view you just saved.

Next choose 'Edit | Find point'. In the dialog box, check that centering is on and ask for "Glu A 177", which is
the active-site Glu of ricin; KiNG will center on Glu 177 (and move the Marker to it (visible if Markers are
turned on)). 

Zoom in somewhat, choose a view for the A chain that shows both the central beta sheet and the region of the
active-site Glu, and save it with a name of "A chain". 

Now pickcenter between the two domains of the B chain, zoom in, and save a view that shows the domains
fairly equivalently, in a vertical orientation to allow for stereo. Locate the place where the chain moves
between the two similar halves of the B chain, and make a note for yourself of that residue number:
________. (You could use it later to put the two domains under the control of separate buttons.)



Improving the colors and button names, and saving your modified kinemage

The Edit Properties dialog box has a good layout of available named colors. (For future reference note that to
see the kinemage color palette and suggestions on color usage, go to Help->Built-in kinemages->Internal
palette, which will bring up a kinemage with samples of the available colors. Read the color-use suggestions
in the text window of this kinemage. [Optional: open the "Color cone" internal kinemage to see how the
selected colors relate to one another in a hue-saturation space.] [KiNG can also display custom colors by
RGB value.] Choose "Close" on the file menu to get rid of this internal kinemage and go back to your
working kinemage.) 

Select 'Edit list props' in the 'Edit / draw / delete' on the Tools pulldown menu. Click on a sugar atom. Click
the white swatch (it will say "white" when the mouse hovers over it), and click OK. Now you need to change
the colors of the two subunits, A to differ from the white sugars and B to contrast better with the yellow SS
bonds. The "tint" colors work well for Calpha backbones, because they can be distinguished without
overwhelming small features you want to emphasize. Make the A chain yellowtint and the B chain greentint
(try out some other possibilities, too).

Select 'Reveal in hierarchy' from the 'Edit / draw / delete' tool palette, and pick a sugar atom. The resulting
dialog box will show you the program's internal data structure for this item. 
Although the sugars are all attached to the B Chain, for convenience now, keep them in a separate group. 

Edit the group name (created as "2AAI") to "sugars" by selecting it and clicking the 'Properties' button.
(Make sure it has the 'dominant' option below it checked, which hides its subgroup and list buttons on the
button panel.) 

Accept the result, and see how the button has changed. Then edit the group names for the protein subunits,
from "2AAI A" to "Ricin A ch" and from "2AAI B" to "B chain". It's a good idea to keep names short, about
10 characters or less. If you're not sure which group corresponds to some part of the protein, use 'Reveal in
hierarchy' again. 

Remember to Select "Do nothing" in the Edit/draw/delete palette! 

Choose 'Save as', under the File menu, and choose to save only your current kinemage if you have more than
one still open. You will be given a dialog box to locate and name the saved file. Be sure to add ".kin" to the
end of the file name. Once saved, you can continue with this kinemage. (In the extreme you could Choose
'File | Close all' to reset KiNG after saving the file, then reload the saved kinemage to continue editing it.)
(Just the usual advice for edit jobs: save often so you can recover from mistakes, particularly when about to
do a new sort of edit.) 
However, now continue with adding to this kinemage...



Making more pieces to add to the kinemage

The carbohydrates in ricin are "N-linked" - bound to Asn sidechain N atoms. In order to find and show those
linkages, and produce other useful vectors for your kinemage, run Molikin on PDB file 2AAIed again to
produce 2 different types of output: a) vectors for the active-site Glu 177 sidechain in the A chain, b) all the
Asn sidechains of the B chain. To achieve this, click on the Molikin dialog you used before (which is now
may be behind the main KiNG window). If continuing on with the kinemage: it would have one ball-and-
stick entry with 'C-alpha trace' and 'disulfides' selected, unselect that one by clicking "(-)Selected" , then
Click '(+) Ball & Stick' to add another ball-and-stick entry. Adjust the selection to chain A (only), residue
177, and only the 'protein', 'sidechain', and 'balls on N, O, P' boxes selected. Add a third ball-and-stick entry
the same way, but for chain B, all residue numbers, protein, 'balls on N, O, P', and only Asn sidechains. Click
'Append to current' to see the results in KiNG. 
Two more groups have buttons: change their names appropriately, e.g. "2AAI A" to "Glu A 177" and "2AAI
B" to "Asn B chain". 
If you made a mistake, you can 'File | Close all' and adjust the settings in Molikin to try again.

Using Drawline to draw sugar-Asn bonds, and Prune to delete unused Asn

Zoom in on the B chain and turn off everything but the Asn sidechains and the sugars. Turn on 'Draw line
segments' in the 'Edit / draw / delete' tool. For each of the two long (5-sugar) carbohydrate chains, find an
Asn whose Nd2 atom is close enough to be covalently bonded (around 1.4 Å) to a sugar atom; to add a line
for the bond, pick the two atoms. Then, change 'Shorten lines by' to 0.7 (an absolute shortening, in Å) and,
for each of the two-sugar chains, find an Asn whose Nd2 is H-bonded to a sugar atom (2.5-3 Å distance) and
click on the two atoms to add a shortened line to represent the H-bond. (Switch to 'Do nothing (navigate)'
while measuring the distance, but if you accidentally draw an unwanted bond remove it with 'Undo drawing'.)
For your own possible use later, note the residue numbers of these four Asn: ________, ________,
________, ________.

The 'Edit / draw / delete' tool has 3 buttons for deleting stuff: 'Punch' deletes single vectors or two that join at
the point you picked; 'Prune' deletes a connected string of P, L, L vectors; and 'Auger' removes things in a
circle around the picked point. 'Undo drawing' will undo previous deletions in reverse order, up to about 10
steps back. Find an Asn far from any sugars, and try out these functions. Then remove all the unconnected
Asn's, using either 'Auger' or two prunes at the Cgamma branch point for each one. 

Now there is a new "Drawn Obj" group and button that has only the connections of the asn and sugar pieces.
In the "Hierarchy window" add a new subgroup to "Asn B chain" group, select the "Drawn vectors" of the
new Drawn objs group and cut that vector list and paste it into the "New subgroup" of the Asn B chain group.
Then the empty "Drawn objs" group can be deleted. 
Make sure that the Buttons are appropriately labeled and function as desired. 
Save the modified kin.

Write text and caption

In KiNG again, press the 'Show Text' button in the lower right corner. In the text window, put a title at the top
in caps, your name(s) as author(s), then a blank line, "Kinemage#1 Ricin A and B chain, with Glu 177, SS,
and sugars", another blank line, and a paragraph or so about what a reader should look for in the kinemage,
including a description of what is shown and what the colors mean. Leave in the PDB file name, at the
bottom, but you may not want all the header information. Save the file.



(KiNG only has one text window for all kinemages in a session and text accumulates that might have to be
edited out later from a saved kinemage.)

Before quitting, examine the kinemage again. If you were the reader, would you learn significantly more from
this version than from the original default kinemage? Could you imagine giving a presentation with this
kinemage as your graphics? This example was more complex than most, to introduce you to a variety of
authoring tools. We hope it convinced you that worrying about how the kinemage looks is worthwhile, and
that the process is fun.  



Kinemage 2 - A Ribbon Schematic of both Ricin Chains

Molikin can make either a simple, default ribbon with no secondary-structure information, or else it can do
arrows for beta strands, spiral ribbons for helices, and widened single splines for coil. In order to do the more
interesting ribbons for both chains of ricin, you will need to use an edited PDB file called 2AAIed.pdb, with
"sheet" records for chain B as well as chain A added to the header. (2AAIed.pdb is available from
http://kinemage.biochem.duke.edu/teaching/bch622/.) (Note, Sheet and Helix records are now standard for
pdb files)

Open the PDB file iin Molikin with File/Import/Molecule, or choose Open in Molikin from a drag-n-drop.
Click '(-) All' to remove the default ball-and-stick rendering, then '(+) Ribbons'. Accept the defaults and click
'As new kinemage'. 
Bring forward the Molikin Dialog box again and select "-All" to clear previous selection, then select "balls &
Sticks" for Chain A Glu 177 protein, sidechains, with ball on N,O,P,etc., click on "Append to current". 
Find a orientation that looks into the active site cleft at the catalytic Glu 177, save a good view of this.
Although there are tools within the KiNG GUI to do a lot of editing of properties, since ribbons are rather
complicated this is a good opportunity to see the power of editing the kinemage in its text form. Indeed,
ribbon colors are more easily edited directly in the text form. 
Work with this in the text view of a kinemage: File/Save as... (for instance "Kinemage#2-ribbon.kin".

Adding details, and changing ribbon colors

In a TEXT EDITOR (if using a word processor remember to save as plain text), look at the ribbon kinemage,
which has vectorlists for the edges of strands, vectorlists with "width4" for the splines in coil, and ribbonlists
for the beta strands, and for alpha helical regions. 

The kinemage text starts with some general specifications, then is organized into blocks following @group
{name} 
Edit the @group {name} to be more descriptive, e.g. "2AAI A" to "ricin A chain", "2AAI B" to "chain B". 
Note that the group with the added Glu A 177 is at the end of the kinemage! Cut and paste and rename that
group to be a subgroup at the end of the A chain group before the @group {chain B} block of text. 
Just above that is a list of the masters; you can change the order of those lines in order to control the order of
master buttons on the screen. 

Note the line that reads '@colorset= {betaA} lime' -- this is a way to treat colors as variables, and lets you
easily change the color of beta ribbons, which we will use to tell the chains apart. Edit the beta colorset for
chain B to sky. KiNG GUI does not have a way of changing the colorset parameters. Save as a plain text file.

Reopen in KiNG, Look at the kinemage, and save views for each chain. 
Menu "Views/Edit saved views" will let you delete the initial arbitrary view KiNG made at input.

These dark ribbon colors are really better seen with the Display/Ribbon sides/turn off "color by side (alpha)". 
Make note of anything that needs fixing. Edit the text and caption to say something suitable. Save the
kinemage again.



Kinemage 3 - Active Site, With Atom Balls and H-bonds

The 'Spherical crop' option to show only near-site sidechains keeping full mainchain for context,
and active-site details

Run KiNG/Molikin on file 2AAIed. Do a ball-and-stick rendering of chain A protein with mainchain and
sidechains.
Save this as a new kinemage. Then Run KiNG/Molikin again on file 2AAIed with A chain and 4 ball and
sticks selections of sidechains and balls on N,O,P... for Arg A 180, Glu A 177,208, Tyr 80,123, and Trp A
211. This can be done by listing just the residue numbers in any order since the residue identities are known
by their residue number. 
Save as append to current kinemage. Use 'Edit | Find point' to find the C-delta of Glu 177 by entering "177
cd". Zoom in.

Spherical crop to limit neighboring sidechains, pruning sidechain fragments, and drawing H-bonds

Choose and save a view that gives a good closeup of the active site cleft. The C-gamma of catalytic Glu 177
is a possible center for this view... Turn on "Markers", for your own feel for context of the active site: roll the
molecule around, and look for a direction that shows Glu 177 with some space in front of it. Turn off the
manichain and make sure all desired neighboring sidechains and where they either branch or H-bond to the
mainchain are within the radius to be set for the spherical crop; this is important or they will be deleted! Turn
"sidechains" on so they will be cropped and the "mainchain" off so backbone will stay intact. From the
'Edit/draw/delete' tool, choose 'Spherical crop' and set the radius to 12 (or what you think a better choice).
Click the C-delta and notice that many of the sidechains are pruned away. Be careful with the spherical crop
tool - you can't undo its actions. The sidechains with N,O balls should all remain, i.e., the two Glu (177,208),
the two Tyr(80,123), the Arg (180), and the Trp (211). Use 'Draw line segments' to draw in the sidechain H-
bonds with 'shorten lines' set to 0.7. There should be 3 H-bonds to main chain, from the Arg, Trp, and one
Tyr. Now, prune or auger away the sidechain fragments left by the arbitrary spherical crop. 
Find and save a good view for these active site residues. Note that the "Views" menu has provisioin to edit
and rename views. 
Also Edit/Edit hierarchy will let you redefine group names for the right-side panel buttons.
Save the kinemage which will become Kinemage#3-active-site for the final combined kinemage.

Kinemage 4 - Superimposing the Two Domains of Ricin Chain B

Chain B has two domains that each have the "beta trefoil" fold; superimposing them can show how similar
they really are. We will use the beta strands, the disulfides, and especially 3 of the Trp sidechains as
landmarks for doing the superposition in KiNG with its docking function.

Open 2AAIed.pdb in KiNG and select Open in Molikin. 
Create a ball and stick rendering of protein with C-alphas and disulfides for chain B, residues 7-138. 
Create a second ball and stick entry for Trp sidechains, chain B, residues 7-138. (The N-terminal tail is not
equivalent and the domain changeover point is at about residue 138.) Click 'As new kinemage'. Now re-edit
the Molikin Dialog to change both ranges to 138-355, and press 'Append to current'. (This ensures the two
subdomains show up as separate groups, to facilitate docking.) Rename the groups to "Domain 1" and
"Domain 2" if you like.

You should see all of chain B, with Trp sidechains in cyan and SS in yellow. Turn off the second button on
the panel (domain 2) and use 'Tools | Edit/draw/delete Edit list props' to make the domain 1 Calphas another



color, like lilactint. From default view, Drag with the mouse down and a bit left to get a view down the 3-fold
axis of domain 1 - you should see 3 Trp sidechains as symmetrical "T" shapes, with a triangle of Calpha
strands evenly behind a central opening. Recenter if necessary. Save this view with a name like "3-fold".
There are 2 other Trp in domain 1 that are not symmetrically related around the 3-fold; use 'Auger' (with the
C-alphas hidden!) or 'Prune' to delete them. Turn on Domain 2 and make its Calphas some other color
(maybe peachtint). Find the 3 symmetrical Trp in domain 2 and prune away the extra, fourth one.

The Dock 3-on-3 Function

To get the 3-point docking tool, choose 'Tools | Kin editing | Dock 3 on 3', which will pop up a new small
window. Pick the 3 Trp Calphas of domain 1 in counterclockwise (sequence) order, starting with the one
between the two SS; numbered markers will appear in sky blue. This defines the "destination" for docking
domain 2 (the "reference" object). Drag down and left (if you hit an atom, use eraselast) for a similar view of
domain 2, and pick its 3 Trp Calphas also CCW starting between the SS. BEFORE PRESSING THE 'DOCK'
BUTTON, turn OFF domain 1. Dock 3-on-3 moves whatever parts of the kinemage are visible, and leaves
alone those parts that are hidden. Domain 2 should jump on top of domain 1. Dock3on3 is not a root-mean-
square function but superimposes the first point exactly, as you can now see. The other 2 Trp and the 2 SS all
look offset in the same direction, so try this again. (Making a reasonable superposition is usually an iterative
process.) Turn off domain 2 and pick CCW but starting with the 2nd Trp this time; then turn domain 2 on and
1 off, and pick the equivalent 3 Trp in the same order (you needn't worry about the markers, which are
unpickable). With both domains on, this should show a good match. Which parts line up closely, and which
parts differ? 
Put away the Dock3on3 dialog (or uncheck its selection in the menu pull down).

Animating

Can you indeed see convincingly now that these two domains have the same fold? They are almost certainly
related by a gene duplication. To set up animation between the two structures, use 'Reveal in hierarchy' or
'Edit group props' from the 'Edit / draw / delete' tool to bring up group properties for Domain 1 and Domain
2. Check the 'animate' box. Notice that the buttons now have stars (*) in front of them. Then animate with the
"a" key. Remember you can still turn on both at once. Save the kinemage.



Assembling a multi-part kinemage file

Save any kinemages you're currently working on. Then use 'File | Close all' to reset KiNG. Open the four
kinemage files you've made in sequence - first #1, then #2, etc. 

Think of these 4 closely related kinemages as telling a story. Consider how you would use them in a
presentation. Change or make new views in various ones to help you present one of the possible stories. For
instance, kins 1,2,3 could all have approximately matched views of the active site. The ribbon kinemage
could have a view that shows the trefoil pattern of one of the domains of kinemage 4. Go through the set a
few times imagining doing a presentation - what would you want to show? Perhaps even change the order of
the kinemages shown (Since you will be real-time, interactively controlling the presentation, you could either
change the order in the combined file, or just know to show the kinemages in your preferred order. 

Edit the text window to make everything flow together. 

When satisfied at this stage, choose 'File | Save as' and tell KiNG that you want to save all the open
kinemages into one file. (You can accomplish the same thing in a text processor by cutting and pasting the
kinemages one after another.)

You have now made a quite complicated kinemage file, which illustrates a number of interesting things about
ricin. Congratulations!


